N

MICROCHIP

MEC141x Family Device
MECC Evaluation Board
User’s Guide




Note the following details of the code protection feature on Microchip devices:
. Microchip products meet the specification contained in their particular Microchip Data Sheet.
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allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.
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otherwise, under any Microchip intellectual property rights unless otherwise stated.
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EU Declaration of Conformity

Manufacturer: Microchip Technology Inc.
2355 W. Chandler Blvd.
Chandler, Arizona, 85224-6199
UsAa

This declaration of conformity is issued by the manufacturer.

The development/evaluation tool is designed to be used for research and development in a laboratory
environment. This development/evaluation tool is not a Finished Appliance, nor is it intended for
incorporation into Finished Appliances that are made commercially available as single functional units to
end users under EU EMC Directive 2004/108/EC and as supported by the European Commission’s Guide
for the EMC Directive 2004/108/EC (8" February 2010).

This development/evaluation tool complies with EU RoHS2 Directive 2011/65/EU.

This development/evaluation tool, when incorporating wireless and radio-telecom functionality, is in
compliance with the essential requirement and other relevant provisions of the R&TTE Directive
1999/5/EC and the FCC rules as stated in the declaration of conformity provided in the module
datasheet and the module product page available at www.microchip.com.

For information regarding the exclusive, limited warranties applicable to Microchip products, please see
Microchip’s standard terms and conditions of sale, which are printed on our sales documentation and
available at www.microchip.com.

Signed for and on behalf of Microchip Technology Inc. at Chandler, Arizona, USA

(2-Sep— 1%
Derek Carlson ' Date
VP Development Tools
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Preface

NOTICE TO CUSTOMERS

document.

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the

For the most up-to-date information on development tools, see the MPLAB® IDE online help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MEC141x family device MECC evaluation board. Items discussed in this chapter
include:

Document Layout

Audience

Reference Documents

Glossary

The Microchip Web Site

Development Systems Customer Change Notification Service
Customer Support

Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MEC141x family device MECC evaluation
board (ASSY-6760 Rev. A) to mate with Intel’s latest generation reference board’s
MECC connector or use as standalone development board. The User Guide layout is
as follows:

Chapter 1. “Overview” — An introduction and overview of the MEC141x MECC
Board.

Chapter 2. “Evaluation Boards” — Includes hardware setup information and
demonstration procedures.
Appendix A. “Intel Skylake Platform Rework Instructions” - Provides the

rework steps for the Intel Skylake RVP motherboard, eSPI configuration with the
MEC141x MECC Add-In Board.

© 2014-2016 Microchip Technology Inc. DS50002312B-page 7
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AUDIENCE

This document is written for developers who are familiar with testing and design of Intel
personal computer mobile systems, or generic embedded controller applications envi-
ronment. The purpose of this document is to describe the functions and use of the
MEC141x family device MECC evaluation board when connected to Intel’s latest gen-
eration reference validation platform (RVP) that supports the MECC connector to per-
form the appropriate drivers, BIOS, and components development and validation, or
running standalone for other embedded controller applications.

REFERENCE DOCUMENTS

GLOSSARY

MEC140x/1x Data Sheet, Rev. A

MEC140x/1x eSPI Addendum, Rev. A

ASSY. 6760A - MEC141x 128 VTQFP eSPI MECC Card, Rev. A1.0 Schematics
MPLABX IDE Tools Documentation

- http://www.microchip.com/pagehandler/en-us/family/mplabx

Intel eSPI Specification, June 2013, Revision 0.75 (Doc#: 327432-003)

Intel Skylake Platform Design Guide, June 2014, Revision 0.9 (Doc#: 543016)

Intel Skylake Ultrabook Platform Y-Series RVP3 CRB Schematic, March 2014,
Revision 0.72 (Doc#: 544250)

Intel Skylake Y EC AIC Enable Document for rework instructions to enable eSPI

This section describes glossary terms and acronyms used in this document.

EVB Evaluation Board

MECC Modular Embedded Controller Card

ASSY. Assembly Number Assigned to the Microchip EVB
ACPI Advanced Configuration and Power Interface
BIOS Basic Input/Output System

ASL ACPI Source Language

EC Embedded Controller

AIC Add-In Card

LPC Low Pin Count

eSPI Enhanced Serial Peripheral Interface

DS50002312B-page 8
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THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

» Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip
products. Subscribers will receive e-mail notification whenever there are changes,
updates, revisions or errata related to a specified product family or development tool of
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

+ Compilers — The latest information on Microchip C compilers, assembilers, linkers
and other language tools. These include all MPLAB C compilers; all MPLAB
assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK
object linker); and all MPLAB librarians (including MPLIB object librarian).

+ Emulators — The latest information on Microchip in-circuit emulators.This
includes the MPLAB REAL ICE and MPLAB ICE 2000 in-circuit emulators.

* In-Circuit Debuggers — The latest information on the Microchip in-circuit
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 debug
express.

* MPLAB IDE - The latest information on Microchip MPLAB IDE, the Windows
Integrated Development Environment for development systems tools. This list is
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and
MPLAB SIM simulator, as well as general editing and debugging features.

* Programmers — The latest information on Microchip programmers. These include
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included
are nonproduction development programmers such as PICSTART Plus and
PIC-kit 2 and 3.

© 2014-2016 Microchip Technology Inc. DS50002312B-page 9
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative
* Local Sales Office

+ Field Application Engineer (FAE)

» Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at:

http://www.microchip.com/support

DOCUMENT REVISION HISTORY

Revision

Section/Figure/Entry

Correction

DS50002312B (10-24-16)

Document Release
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Chapter 1. Overview

1.1 INTRODUCTION

FIGURE 1-1:

The MEC141x family device MECC evaluation board (ASSY 6760A) is mainly
designed to be used with the Intel Skylake Y-Series RVP platform. The MECC board is
a vehicle to support the development of BIOS, drivers, firmware, and so forth. This
evaluation board can be also used as a standalone embedded controller development
board for embedded and industrial computing applications.

The purpose of this document is to describe the functions of the MEC141x MECC eSPI
Plug-In card as well as the setup procedures for full system development, to validate
applications, or to power-up as standalone board for application development.

There are several on-board LPC devices on the Intel Skylake RVP platform. There is

also an on-board MECC (AIC) connector to provide the capability for other vendors to
develop and test their LPC/eSPI devices. The MEC141x family device MECC evalua-
tion board is designed to plug into the MECC connector to demonstrate the operation
of the MEC141x family devices on this platform. This user manual focuses on the Key-
board Controller and Embedded Controller functions available on the plug-in card.

MEC141X MECC CARD (ASSY 6760A) TOP & BOTTOM VIEWS

Bottom View

.........

© 2014-2016 Microchip Technology Inc. DS50002312B-page 11
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1.2 INTEL PLATFORM SETUP REQUIREMENTS

1.21 Hardware

Intel Skylake Y-Series RVP Platform (with eSPI support)

Microchip MEC141x family device MECC Card (ASSY 6760A)

SPI Flash Programmer

- Dediprog SF100 (http://www.dediprog.com/pd/spi-flash-solution/sf100)
Skylake specific LCD Display or eDP support LCD Monitor

2.5” Notebook SATA HDD

USB or PS/2 Keyboard & Mouse

Optional - Microchip Pegasus Trace FIFO Debugger (Part#: PEGASUS-EVB)
Optional - Select one of the Microchip Debugger Tools

- PICKit3 (Part#: PG164130)

- ICD3 (Part#: DV164035)

- Real ICE (Part#: DV244005)

- RJ11 to ICSP Adapter (Part#: AC164110) - Required for ICD3 or Real ICE

1.2.2 Software

Microchip MPLABX IDE v2014-08-22 or later
Microchip XC32 PRO Compiler v1.33 or later

SPI Flash Programming Ultility (ex: Dediprog utility)
Microchip MEC141x SPI Flash Generator Utility
Microchip MEC141x Firmware Sample Code

1.2.3 BIOS Support

Please contact Intel or your BIOS vendors if you need any BIOS related information or
support.

1.3 STANDALONE SETUP REQUIREMENTS
1.3.1 Hardware

Microchip MEC141x family device MECC Card (ASSY 6760A)

External +3.3V Power Supply

SPI Flash Programmer

- Dediprog SF100 (http://www.dediprog.com/pd/spi-flash-solution/sf100)
Optional - Microchip Pegasus Trace FIFO Debugger (Part#: PEGASUS-EVB)
Optional - Select one of the Microchip Debugger Tools

- PICKit3 (Part#: PG164130)

- ICD3 (Part#: DV164035)

- Real ICE (Part#: DV244005)

- RJ11 to ICSP Adapter (Part#: AC164110) - Required for ICD3 or Real ICE

1.3.2 Software

Microchip MPLABX IDE v2014-08-22 or later
Microchip XC32 PRO Compiler v1.33 or later

SPI Flash Programming Utility (ex: Dediprog utility)
Microchip MEC141x SPI Flash Generator Utility
Microchip MEC141x Firmware Sample Code

DS50002312B-page 12
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Chapter 2. Evaluation Boards

This chapter describes the MEC141x family device MECC card (ASSY 6760A) detailed
information.

21 FEATURES

The MEC141x MECC Evaluation Board has the following components and features:

211 MEC141x MECC Evaluation Board (ASSY. 6760A)

*+ MEC141x Embedded Controller
» 32 KHz Crystal
» SPI Flash (W25Q128FV)
* UART Transceiver
» Power LED
» Connectors / Headers:
- Intel MECC (AIC) Connector
- eSPI Access Header
- Powers Isolation Headers
- SPI Flash Programming header (for Dediprog SF100 pin-out)
- Two pins UART header
- Unused GPIO headers
- JTAG/ICSP debugger headers
- Pegasus debugger header

2.2 HARDWARE SETUP

2.21 Intel Skylake Y-Serial RVP

- Plug-In LCD Display or Monitor

- Plug-In USB or PS/2 Keyboard and Mouse

- Plug-In USB DVD-ROM if required to install Windows
- Plug-In 2.5” SATA HDD

- Plug-In Skylake platform power adapter

- Press the power button to make sure the platform is boot-able to UEFI Shell
or Windows 8.x

2.2.2 MEC141x MECC Evaluation Board (ASSY 6760A)

- Refer to Table 2-1 for jumper settings.

© 2014-2016 Microchip Technology Inc. DS50002312B-page 13
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TABLE 2-1: JUMPER SETTINGS ON MEC141X MECC BOARD (ASSY 6760A)
Jumper Function Setting
JP1 VTR_33_18 Power Select <1-2> for +1.8V
<2-3> for +3.3V (Default)
JP2 ADC_DAC_VREF to +3.3V <IN> Connected (Default)
<OUT> Disconnected
JP4 PECI VREF_CPU power select <1-2> Connect to Intel platform (Default)
<2-3> Connect to ground
JP5 VTR to +3.3V <IN> Connected (Default)
<OUT> Disconnected
JP6 VBAT to +3.3V or Coin Battery <IN> Connected (Default)
<OUT> Disconnected
JP7 TFDP or UART signals select <1-3 & 2-4> Connect to Pegasus TFDP header (Default)
<3-5 & 4-6> Connect to UART header
JP8 +3.3V to V3.3V_EC_CORE <IN> Connected (Default)
<OUT> Disconnected
JP9 nRESET_IN Group Option <IN> Connected to ground (use for SPI flash program)
<OUT> Disconnected (Normal Operation)
JP10 System +3.3S to EC V3.3S <IN> Connected (Default)
power well <OUT> Disconnected
JP11 System +3.3A_RTC to EC <IN> Connected (Default)
V3.3A_RTC power well <OUT> Disconnected
JP13 System 1.8V_ESPI to EC <IN> Connected
RSVD_1.8V_ESPI power <OUT> Disconnected (Default)
(Reserved for internal only)
JP14 Grounded ICSP_MCLR <IN> Grounded
<OUT> Not grounded (Default)
J1 Microchip ICSP Header Connect to Microchip PICKIit3 or ICD3 or Real ICE debugger
J2 SPI programming header Connect to Dediprog SF100 SPI flash programmer
J3 Two pins UART header Connect to UART (Null-modem) Cable
J4 Trace FIFO Debugger header Connect to Microchip Pegasus board
J5 Ground the +5V Target Power Not Used - Do Not Connect
J7 1x6 JTAG Header (Reserved for Not Used - Do Not Connect
internal only)
J8 eSPI Access Header Not Used - Do Not Connect
J9 Unused GPIOs Header Not Used - Do Not Connect
J10 Empty Header Not Used - Do Not Connect
TP1 +V3.3A Test Point for V3.3A power
TP2 EC_SPI_OE__N Test Point for System EC_SPI_OE_N signal
TP4, TP5, Ground Test Points to ground
TP6 VREF_ADC Test Point for VREF_ADC power

DS50002312B-page 14
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2.3 SOFTWARE SETUP
2.31 Microsoft Windows 8.x on Intel SkyLake Platform

» Make sure the Intel Skylake platform is boot-able and able to complete the Micro-
soft Windows 8.x installation accordingly, and able to boot to the Windows 8.x.

» Please contact your Intel representative if you need any further assistance.

2.3.2 Microchip XPLABX IDE

* Install the beta version 2014-08-22 or later.

» Double click on the installation file, MPLABX-v2014-08-22-windows-installer.exe
under the developer’s windows machine.

» Follow the instructions to complete the installation.
» Please contact your Microchip representative if you need any further assistance.

233 Microchip XC32 PRO Compiler

* Install the beta version 1.33 (that supports the MEC141x family devices) or later.

» Double click on the installation file, xc32-v1.33-full-install-windows-installer.exe
under the developer’s windows machine after installing the MPLABX.

* Follow the instructions to complete the installation.

» At the end of installation, please follow the instruction to activate the XC32 PRO
license key.

- User can use xclm.exe in the compiler directory (ex: C:\Program Files
(x86)\Microchip\xc32\v1.33\bin) to check the status by “xclm -status” com-
mand.

» Please contact your Microchip representative if you need any further assistance.

© 2014-2016 Microchip Technology Inc. DS50002312B-page 15
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24 HARDWARE CONNECTION
Intel Skylake Y-Serial RVP Connection

241

This section shows the hardware connection between Intel Skylake RVP platform and
the Microchip MEC141x family device MECC evaluation board along with other com-

ponents.

E

1. Connect Microchip Real ICE to the MECC J1 with RJ-11 to ICSP adapter
2. Connect Pegasus Trace Debugger to the MECC J4 — for trace debugging
3. Connect Dediprog SF100 to J2 for SPI flash programming

DS50002312B-page 16
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2.4.2 Standalone MEC141x MECC Card Connection

In the standalone setup, on top of steps 1 to 3 as described above for debug and devel-
opment tools connections, we need to connect the power from external +3.3V power
source since we don’t have the sources from Intel platform.

4. Connect MEC141x MECC Card JP8 Pin 1 (3.3_EC_CORE) to an external +3.3V
power supply.

5. Connect a solid good ground source from the same power supply to the
MEC141x MECC Card ground pin such as TP38 Pin 2, or TP4, or TP5, etc.

25 MPLAB IDE BRING UP
1. Launch the IDE - from Start > All Programs - Microchip > MPLAB X IDE -

N MPLAB X IDE

2. Open Existing project — MPLabx IDE > File> Open Project, Navigate the
browser to the project setting files [+ @ which have the project name with .X
extension. Right Click on project name and set Project as main project.

=&

@ (] Header New 3
& [ Importa

i UnkerF  Add Edsting ltem...
o (] Sourcet Add Existing ltems from Folders...

+ E‘ Libraries
[ Loadabll

New Logical Folder

Locate Headers

Add Item to Important Files...
Export Hex

Build

Clean and Build

Clean

Package

Set Configuration v

Run

Debug

Step into

Rename...

= ’“ﬂ Compilg Move...

2.6 MPLAB IDE DASHBOARD

MPLABX IDE - Window > DashBoard will give details of the project for:
1. Compiler Toolchain

2. Memory Used

3. Debug tool

4. Debug resources

© 2014-2016 Microchip Technology Inc. DS50002312B-page 17
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2.7

2.8

: meci418_ex1 - Dashboard < =2

g mec1418_ex1
i--Yg Project Type: Application - Configuration: default

i Checksum: MA
E—]L‘d" Compiler Toolchain
-’ %C32 (v1.33) [C:\Program Files (x86)Microchiplxc32\v 1.33\bin]
L‘L‘f Production Image: Optimization: goc Os goc++ Os
Elm Memory
- Usage Symbols disabled. Click to enable Load Symbols.
- [d Data 32768 (0xB8000) bytes
‘[ Program 163840 (0x28000) bytes
- #g Debug Tool
¢ LD Real ICE: JIT133210156
-7 Debug Resources
EI Program BP Used: 0 Free: 4

OHED S
m

-0 Data BP Used: 0 Free: 2
-0 Data Capture BP: Mo Support
O Unlimited BP {5,W): Disabled

PROJECT CLEAN AND BUILD

To compile the project, right click on project name and choose either “Build”, “Clean and
Build”, or “Clean” option. From Menu bar MPLABX IDE-> Run - Build Main Project /
Clean and Build.

i[5 He: MNew '
ﬁ' Img
ﬁ Link Add Existing temn...

ﬁ SoL Add Existing Items from Folders...

(& Libr Mew Logical Folder
ﬁ;‘ Loa

Locate Headers

Add Itern to Important Files...
Export Hex

Clean and Build

Clean

BUILD PROJECT FOR DEBUGGING

To debug the project with Real ICE, make sure the connection is correct and the proper
Drivers are installed for the Debugger.

. _
From the Menu Bar select = or

Run |Debug| Team Tools Window Help

From MPLABX IDE -

— Debug File Ctrl+Shift+F5

DS50002312B-page 18 © 2014-2016 Microchip Technology Inc.
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Project will be rebuilt with debug option.

& MPLAB X IDE v2.

RC1 - mec1404 default

File Edit View Navigate Source Refactor Run Debug Team Tools Window Help

S

default 1% -8 %ﬂ - lﬁm - ~ {pc: ovaFDO5IBA

@ uiFiles |

[ eustom precisosid s T misc hm mines | E man.c |

- mec1404_ex1
(5] Header Files

(& tmportant Fies
{E5) Linker Files

(&5 source Fies
=g sc

@ ac

[ hmaypto
(i3 indude
&g main
i3 dump.c
- main.c
(i3 MEC1%0c
& pkem
(@ Lbraries

B Loadables

]

B-E8-ATfEeeside |
134 wdt_enable (O
135 wdt_status (i
136
137 ~>ERO
138
133 enable TRACE FI
140 tfdp sleep en(0);
141 tfdp_enable (1, 1};
142
143 0(636, AP3M, O, 3
144

: CPU Memory Data Memon

[ | "c:\icrochipixeazivl a3\bin\nedz-gee. -x € -c -mprocessor=MEC14
"C:\Mierochip\xe32\vl 33\bin\xedZ-gec. -x € -c -mprocessor=MEC14
"C:\Mierochip\xe32\vl 33\bin\xedZ-gec. ~D__MPLAB | -x € -c -mprocessor=MEC14
"C:\Mierochip\xe32\vl 33\bin\xedZ-gec. -D__MPLAB_DEBIUG -x € -c -mprocessor=MEC14
"C:\Microchip\xe32\vl 33\bin\xcdZ-gec . e ~D__MPLAB | -x € -c -mprocessor=MEC14
"C:\Microchip\xe32\vl 33\bin\xcdZ-gec . e ~D__MPLAB | -x € -c -mprocessor=MEC14
"C:\Microchip\xe32\vl 33\bin\xcdZ-gec . e ~D__MPLAB | -x € -c -mprocessor=MEC14
"C:\Microchip\xe32\vl 33\bin\xcdZ-gec . e ~D__MPLAB | -x € -c -mprocessor=MEC14
"C:\Microchip\xe32\vl 33\bin\xcdZ-gec. exe” -g -D_ DEBUG -D_ MPLAB_DEBUG -x € -c -mprocessor=MEC14
"C:\Miecrochip\xe32\vl_33\bin\zcdZ-gec. exe” -g D -D__MPLAB_DEBIUG -x € -c -mprocessor=MEC14

"C:\Microchip\xe32\vl 33\bin\xcdZ-gec. exe™ -g -D_ DERUG -D_ MPLAB_DEBUG -x € -c -mprocessor=MEC14
"C:\Microchip\xe32\vl. 33\bin\xcdZ-gec.exe™  -mdebugger -D_ MPLAB_DEBUGGER_REAL -mprocessor=MEC1418 -mmicromips -o dist/defaul
make[2]: Leaving directory 'C:/depot_pes/FWEng/projects/MEC140x/Dlayground/MEC1404 MPLABX JTVIC Example/mecld0d_exl X'
make[1]: Lesving directory 'C:/depot_pes/FWEng/projects/MEC140x/Dlayground/MEC1404 MPLABX JTVIC Example/mecld0d_exl X'

BUILD SUCCESSFUL (vosal time: &s)
Loading symbols from C:/depos_pcs/FWEng/projects/MEC140x/Playground/MEC1404 MPLABX JTVIC Example/mecl404_exl X/dist/d
Loading code from C:/depot_pcs/FWEng/projects/MEC140x/Playground /MEC1404 MPLABX JTVIC Example/mec1404_exl X/dist/default/debug/mecld
Loading completed

2ult/debug/me

.

() Navigator

A successful build, if Real Ice is connected, will establish the connection and download
the code to the target board for debugging.

|Project Loading Warning = |Conﬁguraﬁon Loading Error x | mecl418_ex1 (Build, Load, ...) = | Debugger Console x= | REALICE x I_

Bunning

Firmware type...

Downloading Firmware

Programming download
Downloading RS5...

Downloading AP. ..

Firmware type...

Target detected

Device ID Revision

program memary:

Programming. . .

Firmware Suite Version..... 01.33.1¢ *

Downloading FPGA (this may take up to 1 minute)
FPEER download complete

Programming download.. .

Downloading bootloader. . .

Bootloader download complete

BS5 download complete
Programming download. ..

AP download complete
Programming download.. .
Firmware Suite Versiom..... 01.34.01

= 0x0

The following memory area(s) will be programmed:
start address = 0x0, end address = O0xll17£ff

Programming/Verify complete

© 2014-2016 Microchip Technology Inc.
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2.81 Breakpoints

Breakpoints can be set before launching the debug option or while target device is
halted. From Dashboard menu we can see the breakpoints available / used.

: mecid18_ex1 - Dashboard 4

%2 mec1418_exi
----- %3 Project Type: Application - Configuration: default
=B @ Device
i MEC 1418
L 48 Chedksum: Debug Image
B- L{f Compiler Toolchain
Lﬁ‘ ¥C32 (v1.33) [C:\Program Files (x&6)WMicrochipiwc32w 1. 33%hin
L}j‘ Debug Image: ELF: Dptlmlzatlon goc Os goc++ Os

-@-BE%&?

EIQ Memnry

= @ Data 32768 (0x8000) bytes
{ 1%,

[ Data Used: 168 (0xA8) Free: 32600 (0x7F58)
=} [ Program 163840 (0x28000) bytes
;----{ 12%

=295 Debug Tool
D Real ICE: 1T133210156
“{§W Press Refresh Debug Tool Status

Program BP Used: 0 Free: 4
Data BP Used: 0 Free: 2
Data Capture BP: Mo Support
Unlimited BP {S,/M): Disabled

Set the break point as required — the break points can be viewed from Menu bar > Win-
dows > Debugging > Breakpoints or short cut key Alt + Shift + 5.

s |Window | Help
& Projects Ctri+1 r %{E -

=[5 Files Ctrl+2
o @ Classes Crl+9 o o P
Favorites Ctrl+3 : na}%l.f, ____|__\I:"i EDL__L_E__
% Services Ctrl+5 - N
ﬁ Tasks Ctrl+6
%2 Dashboard
Output L4
Mavigating L
Debugging <o Variables Alt+5hift+1
Wersioning ¥ 7 Watches Alt+5hift+2
PIC Memory Views Y [ call Stack Alt+Shift+3
Sirnulator ' O  Breakpoints Alt+Shift+5
Other VB Sessions  Alt+Shift+6
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Previously set Break points can be enabled or disabled using the select option.

107 int main(int argc, char** arqgv)
108 ¢

118 wdt status (W
120 FCR->PROC_CL
122 * enable TRACE FIFD *

123 tfdp sleep en(0):
124 tfdp_enable(l, 1);

127
— -

,Makpoims P |£0ulput\\ i Tasks

B | Name
O Line C:\depotAE\Arun_projectidepot_pes\FWEngiprojects\MEC 140xplaygroundMEC 1418_PKERN_Examplemec1418_ex1.X\srcimainimain.c: 113 - Project: mec1418_ex1

A

2.8.2 Enter Debug Task

Select Debug Project (project name xxx) from Menu Bar, IDE will connect ICE and proj-
ect code into chip, then initiate to execute the code, code will be halted at the break-
point which use previous settings.

' MPLAB X IDE v2.20.RC1 - mec1404_ex1 : default
File Edit View Navigate Source Refactor Run Debug Team Iools Window Help

= =5} A efault SF-B-2- - UR- OO0 @ 0 & & G H <5 pooerse

i @ w[ifiles [(C [im. |[[] custom MECi044d | misc hm ininer | E main.c 1w
5 & mectot ent FIH LTIy 2
-[iF) Header Fies e P S T
[ 1mportant Files 1ae s e = outs
(i Linker Files
134 wdt_enable (O
-[g7) Source Files i e
B = e wdt_status
ac - . R
B | |  PcR->PROC_CLOCK CNTRL — (PCR_CLOCK
E-[EF hmerypto o — = - —
&) incluce = o )
B main S
B dump.c 140 tfdp sleep en(0);
- 141 tfdp enable(l, 1):
L s L
MEC 1400
-7 phem : Variables : Call Stack  Breakpoints J: output s
(S Ubraries REALICE x | mecl404_exl (Build, Load, ) #2 x | meci404_ex1 (Build, Load, ..) = | Debugger Console x |
[ Loadables Terger meltea
Connecting to MELAB REAL ICE. ..
Firmware Suite Version ..01.33.16
Firmssre type. ... ... Ipsuich
Target detectea
Device ID Revision = 0x0
The following memory areals) will be programmed
program memory: start address = 0x10000, end address = OX1BEEf
Programming.
Progremming/Verify complete
Running
Target Haltea
i i
() Navigator

mecl404_ex1 (Build, Load, ...
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User can debug code via “step over”, “step into” or “continue”.

3§ MPLA X IDE v2.20RCL - mec1404 ex] : default

File Edit View Navigate Source Refactor Run Debug Team Tools Window Help
i = ST RGN0 00 @ O 61 i G 1 4 o v
(] custom_precisosid = | misc tm_nine.sh m|F man.c =)

1A el [BE-E-QTFEF S |e =

(5 Header Fiies
3 134 wdt_enable (
(& Important Fies = - -
135 wdt_status (WL AR _STATUS) ;
-] Linker Files = = =
136
[& Source Files o
) E a EBCR->PROC_CLOCK_CNTRL = (PCR_CLOCK_DIVIDER).
sre - - - —
138
- ac E . .
&5 rmaypto
7 = tfdp sleep en(0):
include = =
141 tfdp enable(1, 1);
(g main =
142
B dump.c
143 T (636, AP3M, O,
- main.c =
- MEC14xx
i@ phem : Variables : Breakpoints [: output Ch
[ vbraries REALICE * | mecl404_ex1 (Build, Load,...) #2 x | meci404_exi (Build, Load,..) x | Debugger Console x |
(@ Loadables Target Halted

Connecting to MPLAB REAL ICE...
Tirmsare Suite Version ... _01.33.18
-..Ipswich

Firmware type...

Target detected
Device ID Revision = 0x0

The following memory area(s) will be programmed:
program memory: start address = 0x10000, end address = Ox1B££f

Programming. ..
Programming/Verify complate

Running
Target Halted

ol in

() Navigator

mec1404 ext R, Toad. ...}

2.8.3 View Memory or CPU Register Information

As user hits “Pause” to halt code execution, and select “Windows > PIC memory view
> CPU registers”, the registers windows will be shown as:

$€ VPLAB X IDE v220, 1404
File Edit View Novigate Source Refactor Run Debug Tesm Tools Window Help

E % .’ @ efout ﬂ?‘%'&m'%‘\u ' @@@@:@ .PC:DxEFDDSQBA.

i axfifies [ic. [im. | cstompiECIo4d 8| msc m_iinesr | fE) manc |
=W mected Er R = |
Heade e 139|| #elif dsfined(FAST ROTAIE)
[ mportant Fies e -
(5 Linker Files 0
[i5) Source Files .
@ s o
i oc o
hmerypto B
indlude i
(g main . o e
i~ dump.c i E o
] main.c
{65 MEC14xx
) peern : Variables : Call Stack : Breakpoints  Qutput : Tasks
(&5 Ubraries @] |address | Wame s Hex Decimal  Binary Char
(@ Loadables Fl 20 0xBFDIFFSZ 3218210648 10111111 11010001 11111111 01011000 'gHgK'
05 a1 OxEFDIFF5Z 3218210648 10111111 11010001 11111111 01011000 ' NgK'
% 206 az 0x00000010 16 00000000 00000000 00000000 00010000 "....°
— [zo7 23 0xBFC00400 3217032192 10111111 11000000 00000100 00000000 :
01 at OXFFBEFFFT 4290772891 11111111 10111111 T1111111 11111111 "§.9%"
BadVAddr 0xEQ 1035007430 11110000 10000001 01010011 11000110 '0SE'
CacheErr 0 € 10111111 11010001 11111111 01011000 " HgX
Cause 0x00800400 §389632 00000000 10000000 00000100 00000000 ".0.."
COMMBase 0xE0000002 2147483650 10000000 00000000 00000000 00000010
Compare 0x20E6D0AD 552000941 00100000 11100110 11011101 10101101
Config 0xA4210562 2753627522 10100100 00100001 00000101 10000010
Configl 0xE0000002 2147483650 10000000 00000000 00000000 00000010 T
ConfigZ 0x80000000 2147453648 10000000 00000000 00000000 00000000 'O...°
Config3 0x8023E060 2149834248 10000000 00100011 11100000 01100000 :
Configh 0x00000000 0 00000000 00000000 00000000 00000000 ' ..
Configs 0x00000000 0 00000000 00000000 00000000 00000000 "....°
Config? 0x00000000 0 00000000 00000000 00000000 00000000 "...."
Context 6x00000000 0 60000000 00000000 08000000 ... "
Count 0x20641FAC_ 543432620 TI11 10101100 *.d.-"
Datalo 0x00000000 0 00000000 00000000 00000000 00000000 °...."
Debug 0x&0128001 1074356241 01000000 00010010 10000000 00000001 6.0
Memory | CPU Memory - | Format
() Navigator
User program stopped mec1404_ex1 {Build, Load, ...) |

User can view other memory information, e.g. Data or code memory etc.
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284 View Variable

For viewing or examining variables Menu bar - Windows - Debugging Variables or
short cut Alt+ Shift + 1.

Window | Help

E Projects Ctrl+1 :I @ O @ Ii—l
] Files Ctrl+2
. 'Fé] Claszes Ctrl+0 §|
Favorites Ctrl+3 o |<§ =§| o O ‘ &
% Services Ctrl+5
wQ Tasks Ctrl+6
"4 Dashboard
Output
Mavigating
Debugging
Versioning

2.8.5 Exit Debug Task

Select “Finish debugger session”, IDE will terminate debugging task, and return to edi-
tor windows.

2.9 BUILD PROJECT FOR SPI FLASH IMAGE

Please refer to the MEC1418 Firmware Example Code Readme.ixt for more detailed
information.

Steps are shown as below:

1. Extract firmware binary from XC32 ELF output (refer to Section 2.7 “Project
Clean and build”). Use XC32 OBJCOPY utility,

xc32-obcopy -0 binary <ELF-File-Name> <Binary-File-Name>

2. Make sure TOML configuration file (ex: spi16M_cfg.toml) has the proper values
for the firmware binary.
- If you are loading into the start of MEC1418 Code SRAM then use OxBF-
CFO0000 for Load Address.
- With the example projects linker file, the _reset entry point is also at OxBF-
CFO0000 and use this value for Entry Point Address.
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Note: If you use the default MEC1418 XC32 linker file or change the location of

_reset in the custom linker file, please remember to adjust value(s) in the
TOML filel!!!

3. Run the SPI generator,

mecld4xx spi gen -p MEC1418 -i <TOML file name> -o <output binary file name>

291 Program SPI Image to MECC Board SPI Flash

Now, we should have a SPI firmware image (16MB binary) from the build process as
described above. Do the following to program the SPI image to the MECC board exter-
nal SPI Flash image:

1. The MEC141x MECC Board has onboard 3V 128M-bit (16MB) SPI Flash (part#:
Winbond W25Q128FV). If this is being replaced, please follow the example code
then rebuild the binary with correct configuration.

2. Connect the Dediprog SF100 (or SF600) to the MEC141x MECC Board J2
header.

3. Plug-In a jumper to JP9 to hold the MEC141x in RESET state.

4. Plug-In the MEC141x MECC Board to the Intel Skylake RVP Platform or jumper
wire JP8 Pin 1 (3.3_EC_CORE) to an external +3.3V power supply & ground pins
(more is better) from MECC Board to power source.

5. Turn on the Intel Skylake RVP Platform or the external +3.3V power supply.

6. Run the Dediprog programming utility, “dedipro.exe”, the chip selection window.
will pop-up as shown below, please select the “W25Q128FV”.

Memory Type Ambiguit: |

By reading the chip ID, the chip applies to:

S25FL128K

W250128BY
W250128FV
W25H.128FY
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7. The Info sessions on the right side should be shown as below:

"
Windows System Info
I Windows Version: Windows 7
Programmer Info
Type: SF100
Firmware Version: Sl
VCC Status: 3.5V f OFF
VPP[Acc: Mot Applicable
SPI Clock: 12 MHz
Dual/Quad I0: Single 10
Memary Info =
Type: W250128FV
Manufact.: Winbaond Electranics Corp
Size(KB): 16334
Manu. ID: Oxef
JEDEC ID: Oxef4013
File Info
HName :

8. Go to “File” --> “Find” and select the 16MB firmware application binary file, set
the data format as “Raw binary” as shown below:

=
load File o [
File Path: ©C:imecl418_ex2\target\spiléM_image.bin -

Program as

Data Format: (@ Raw Binary ) Intel Hex ") Motorola 519 ) ROM

[ Truncate file to fitin the target area.
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9. Go to “Config” --> “Flash Option”, make sure “Unprotect block automatically

when block(s) protected” option is selected.

Batch
Operations

Frogram
Configuration

i

-
Eng.

Engineering

Mode

Modify Status
Register

Miscellaneous
Settings

Flash Cptions

Options

Unprotect block autamatically when blodk(s) protected,

DS50002312B-page 26
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10. Click to the “Batch”, the SPI flash programming will start, and should complete

successfully as shown below.

(i) 2014-5ep-02 13:19:
(i) 2014-5ep-02 13:19:
(i) 2014-5ep-02 13:19:
(i) 2014-5ep-02 13:19:
(i) 2014-5ep-02 13:19:
(i) 2014-5ep-02 13:1%:
(i) 2014-5ep-02 13:1%:
(i) 2014-5ep-02 13:19:
b 7014-5ep-02 13:20:
(1) 2014-5ep-02 13:20:
(1) 2014-5ep-02 13:20:

(i) 2014-5ep-02 13:13:96:
(i) 2014-5ep-02 13:18:46:
(i) 2014-5ep-02 13:13:45:
(i) 2014-5ep-02 13:13:45:
(i) 2014-5ep-02 13:13:45:
Ll 2014-52p-02 13:18:46:
(i) 2014-5ep-02 13:13:96:
(i) 2014-5ep-02 13:13:96:
15:
15:
15:
15:
15:
15:
15:
15:

14:
14:

Programming parameters:

Source File: spiléM_image.bin(0x 1000000 bytes)
Target Memary Region: [0, 0x1000000)

Spare Memory Region: leave as being erased.
Truncate-File-To-FitMemory Disabled.

Identify Chip OK.

Erasing a whole chip ...

Auto unprotect blodk is enabled

A whole chip erased

Programming ...

Programming parameters:

Source File: spil6M_image.bin{0x 1000000 bytes)
Target Memory Region: [0, 0x1000000)

Spare Memory Region: leave as being erased.
Truncate-File-To-FitMemaory Disabled.

Auto unprotect blodk is enabled

Programming Ok,

COperation completed.

87.401 seconds elapsed.

11. The firmware is now stored in the external SPI flash device. Please remove the
JP9, and do a power cycle (please make sure to wait long enough to have power
supply discharge before re-powering the MECC board). The new firmware
should be loaded by the MEC141x internal ROM to the internal SRAM and start

executing.

Please contact your Microchip representative if you need any further information or

assistance.

© 2014-2016 Microchip Technology Inc.
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MICROCHIP
Appendix A. Intel Skylake Platform Rework Instructions

This section provides the rework steps for the Intel Skylake RVP motherboard, eSPI
configuration with the MEC141x MECC Add-In Board.

Please refer to Intel “SKL_Y_EC_AIC_ENABLE.pdf’ file, and Skylake Reference Sche-
matic, “544250 544250 _SKL_Y_LPDDR3_RVP3_CRB_Schem_Rev0_72.pdf’ docu-

ments.
Note: Highlighted items differ from Intel’s instructions. I
Intel See Component:
Parts | Silkscreen Rework Action P ) Notes
Step Nos. Value / Form / Tolerance
Sheet #
1,2,3 none (n/a) (None) (n/a) (Jumper settings only: Open
J2B5, J2E1; Close J2B7.)
4,5 R4D12 |B2or B3 Move resistor to 22-ohm /402 / 5% 3 pads at right angles: Rotate
position R4D11. the resistor to the other ori-
entation.
6,7 R3D17 [B2or B3 Move resistor to 0-ohm /402 3 pads in a line. Shift resistor
position R3D16 to other position.
8,9 R5E23 |C2 Move resistor to 0.05-ohm /603 / 1% 3 pads in a line. Shift resistor
position R5E22 to other position.
10 R8F35 |C1 Replace 150K (FYlI'was 150K /402 / 5%) | New 4.7K resistor needed,
resistor w/ 4.7K now 4.7K /402 / 5% not supplied.
resistor.
11 R4E24, | B2 Remove resistors. | (FYI 0-ohm / 402)
R4E6,
R4E13,
R4E12,
R4ES5,
R3D32
12 R4D17, |B3 Remove resistors. | (FYI 0-ohm / 402)
R4D15,
R4D18,
R4D16,
R4D19,
R4D13
13, 14 (n/a) (n/a) (None) (n/a) Rework not required
14a (new) |R3E2 |[B3 Remove resistor. (FYI-10K /402 / 5%) Rework required
15 R5E65, | C2 Remove resistors. | (FYI- 10K /402 /5%)
R4E4, |B2
R2N11 | Underside
16 R5F30 |C2 Remove resistor. (FY1-8.2K/402/5%)
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